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Introduction Presentation Outline

A quick tour of the Graphical User Interface (GUI).
Setting up a National run specification.
Running the model.
Discussion of output results.
Feel free to ask questions!
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Advanced Features (not addressed)

Alternate Vehicle & Fuels Technologies strategies 
panel.
Heavy Duty Retrofit strategies panel.
Advanced features panel.
Using XML and batch input options.
Using distributed processing (multiple computers).
Using Core Model Input Tables (CMITs).
Joining MySQL tables.

Since you will see these items as we go through the GUI, I want to warn you in 
advance that we do not have time to address everything that MOVES can do in this 
one short training session.
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Start Master Using Desktop Icon

Start the Master using the desktop icon.  
– Notice the console window associated with the MOVES 

window is started.  Do not close this window.

Stop the Master.  
– Note that console window automatically closed.

If no Worker is present, one will automatically be 
started.

– A Worker application is created to do the calculations when 
you execute the model.



5

5

Console Window

The console window is automatically generated when you run MOVES.  It will show 
you what MOVES is doing while running and will provide useful messages if there is 
a problem.  This window automatically closes when you close the MOVES GUI 
screen.
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Console Window

This Window is automatically generated when 
MOVES is run.
The Window will show any error messages related 
to problems running the MOVES code.
Do not manually close this Window while running 
MOVES.
This Window will automatically close when you 
close MOVES.
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Initial MOVES Screen

This is the initial MOVES screen when you run MOVES.
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Initial MOVES Screen

This is also referred to as the Graphical User 
Interface (GUI) for MOVES.
The Navigation List is in blue in the left hand side.

– Green check means input is ready.
– Red exclamation indicates more information is needed.
– Wavy lines means no input is necessary.

All Navigation List inputs must be green checked 
or wavy lines before MOVES will run.
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File Menu

This slide shows the contents of the File pull-down menu.
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File Menu

The File menu applies to the Run Specification 
(input) files used by MOVES to define a run.
The File menu contains all of the usual options for 
handling these files. 
Selecting New will clear any current items selected.
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Edit Menu

This slide shows the contents of the Edit pull-down menu.
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Edit Menu

The Edit menu applies to any text selected in the 
GUI.
All of the typical options are available for 
manipulating text.
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Pre-Processing Menu

This slide shows the contents of the Pre-Processing pull-down menu.
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Pre-Processing Menu

These items are used to create your own custom 
inputs to represent your location and time.
Edit Inspection & Maintenance (I/M) data.
Update default data values.
Import county specific data.
Create project level inputs.
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Action Menu

This slide shows the contents of the Action pull-down menu.



16

16

Action Menu

Use this menu to initiate a MOVES run.
Options to pause, resume and stop your run.
Once a run is completed, you can review any error 
messages that were generated during the run.
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Post-Processing Menu

This slide shows the contents of the Post-Processing pull-down menu.
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Post-Processing Menu

Use this menu once you have results.
You must select an existing output database.
Options for processing output include:

– Execute existing MySQL scripts.
– Summarize results into text files.
– Graphically represent results in a county map.
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Settings Menu

This slide shows the contents of the Settings pull-down menu.
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Settings Menu

Use this menu to configure MOVES:
– Select default database.
– Select shared working folder.

This is an advanced feature.  Normally no changes 
are needed.
Improper configuration may cause MOVES to stop 
running.



21

21

Help Menu

This slide shows the contents of the Help pull-down menu.
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Help Menu

Access to the User Guide.
Access to the Software Design and Reference 
Manual (SDRM).

– Detailed description of calculation steps.
– Detailed description of calculations.

Display the MOVES version information.
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Help Menu: About MOVES

This is example content of the About MOVES option from the Help pull-down menu.
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Description Panel
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Description Panel

The description should be used to help you 
remember the purpose of your run.
This description will be stored in the Run 
Specification file.
This description will also be stored in the 
MOVESRun table in the output database.
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Scale Panel
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Scale Panel

Three scale options:
– National: Using default values.
– County: Using user supplied local values.
– Project: Link level analysis.

Two result options:
– Inventory: Results in tons (or grams).
– Emission Rates: Results in grams per mile.

Make these decisions first. 
Your choice here will affect other panels.
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Time Span Panel
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Time Span Panel

Choose the time period to be modeled.
Choose the level of detail of the calculations.
Years: 1990, 1999-2050.
Choose a range of hours of interest.
Weekday or weekend days.

– Different activity on each day type.
– Both types needed for weeks, months or years.

If you chose County scale, you may only choose 
one Year.
If you chose the Project Level scale, you may only 
choose one Year and one Hour.
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Geographic Bounds Panel
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Geographic Bounds Panel

Select the location(s) you wish to model:
– county (counties) of interest, or
– state of interest (all counties together), or
– Select the nation (all 50 states and DC).

If you selected the County or Project Level scale, 
you may select only a single county.
You can model a multi-county domain if you select 
the Custom Domain option.

A domain is an area where various parameters are shared.
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On Road Vehicle Panel



33

33

On-Road Vehicle Panel

Select fuel types of interest.
Select the vehicle categories.
Add the combinations.
Warnings will appear for invalid combinations.
Warnings will *not* affect the results.
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Road Type Panel



35

35

Road Type Panel

Selecting only some road types will cause 
warnings.
Rural and urban roads have different driving 
behavior.
Unrestricted roadways have traffic signals.
Restricted roadways are the interstates and 
freeways with entry and exit ramps.
Engine start and some evaporative emissions are 
put in the off-network category.
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Pollutant/Process Panel
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Pollutant & Process Panel

Each pollutant can be generated by one or more 
emission processes.
Some emission processes generate only certain 
pollutants.
Be sure to check all of the emission processes (or 
use the check box on the left) if you want all of the 
emissions of that pollutant from the vehicles 
calculated.
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Pollutant & Process Panel

The calculation of some pollutant/process 
combinations depend on other pollutant/processes 
and both must be chosen.
If you need VMT results, select it here.
Be sure to check the Pollutant/Process 
Requirements box for errors and warnings.
You will likely need to scroll to see all of the 
pollutants and processes.
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Manage Input Datasets
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Manage Input Datasets Panel

This where you indicate a database that replaces 
default data.
The chosen database is assumed to contain the 
data you wish to use in this run.

– There is an option to create an empty database.

You may select more than one database.
Conflicts are resolved by using the data from the 
last database selected.
County specific data is usually entered using the 
County Data Manager.
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User Input - Databases
Default 

Database

User Input 
Database #1

MOVES

Application
MOVES Execution 

Database

User Input 
Database #2

Intermediate 
Result Tables

(Advanced Feature)

County Data

You can have more than one user input database.

User inputs can include intermediate result tables (Core Model Input Table, 
CMIT).
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Strategies Panel
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Strategies Panel

Alternative Vehicle Fuel and Technology (AVFT).
– Select the fraction of diesel vehicles in each model year.
– Options for use of advanced technologies (i.e. hybrid).

On-Road Retrofit
– Alters the emission rates for selected vehicles.
– Used to account for retrofit programs.
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General Output Panel
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General Output Panel

Select a database to place the results:
– Create a database, or
– Choose an existing database.
– Multiple runs will be assigned unique run ID values.

Choose the units for the output values.
You must choose the units for the VMT output if 
you have selected VMT output in the 
Pollutant/Process panel.
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Output Emissions Panel
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Output Emissions Panel

This panel determines the amount of aggregation 
of the output.
The amount of aggregation can only be greater 
than or equal to the level of aggregation chosen in 
the input panels.
The default level of aggregation is by pollutant.
Estimating Uncertainty – Not recommended.
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Advanced Performance Panel

This Navigation Panel item invokes features which may be used to diagnose problems
with the model software, or to improve the run time for long model runs by saving and reusing
intermediate results. Use of these features requires knowledge of the detailed software
components of the MOVES program, the inputs they require, and the outputs they produce.
Users interested in these features should review the MOVES Software Design and Reference

This panel allows users save intermediate results from various portions of the model and
to turn off portions of the model code.
This panel also allows the user to "turn off" final aggregation of MOVES results.
Selecting the "Do Not Perform Final Aggregation" option can reduce execution time for large
runs. However, when this option is selected, the MOVES output tables may include rows with
duplicate key fields. The results from these rows should be summed to produce useful output.

this panel allows users to specify the database to be used when modeling a Custom
Domain. See Section 2.2.4 Geographic Bounds for additional information on the Custom
Domain option.
�Caution! It is possible to undo a custom database selection by hitting the “Refresh” button,
which clears the selected database.
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Advanced Performance Panel

Advanced Performance Features
– This is an advanced feature primarily to reduce run time. 
– Save Data prevents MOVES from destroying intermediate 

result values from the MOVES execution database.
– Don’t Execute assumes that the results are already available 

in the input database or will not be needed for the final results.
– Useful for diagnostics and obtaining intermediate results.

You can choose a custom input database to 
supersede the default database.
Don’t use these features until you understand 
them.

Do not press the shiny red button!
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Configure MOVES Panel
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Configure MOVES Panel

This will show you the name of the default 
database being used by MOVES.
The location of the Shared Work folder is where 
MOVES and the Worker application share files 
when you run MOVES.
Normally, you will not need to make changes in 
this panel.
Changes can cause MOVES to stop working.
Do not make changes in this panel until you 
understand it.  
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Default National Scale

Uses primarily national average default values.
Uses some county specific information.

– Temperatures and humidity.
– Fuel properties.

Allocates national results to counties.
Results do not meet regulatory requirements for 
SIP and Conformity determinations.

Choose National from the Scale panel.
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Setting up a Run Specification

MOVES cannot run without a valid Run 
Specification (runspec).
A runspec indicates the location, time period, 
alternate data and output preferences.
Runspecs can (should) be saved and can be re-
loaded to be run again and/or edited.
The GUI panels are used to set up your runspec.
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RunSpec Cautions

Limit your run specification to just what you need.
Organize your inputs and outputs so you don’t get 
confused.
Use naming conventions to help you identify files.



55

55

Setting up a Run Specification

Enter a Description.
Choose the National scale and Inventory 
calculation.
Choose a single year/month/day/hour.

– This is the only scale where you can choose multiple years.
– Adding more year/month/day/hour will increase the run time.
– Do not use the Time Aggregation Level until you understand it.

Choose one (or more) counties.
– This is the only scale where you can choose multiple counties.
– Adding more counties will increase the run time.
– Do not use the Nation/State regions until you understand 

them.

Using the Time Aggregation Level options will change the results.
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Setting up a Run Specification

Choose a fuel and vehicle type.
– Not all fuel/vehicle combinations are valid.
– Even valid combinations may not produce results.
– Adding combinations will increase run time.

Select the road types.
Select a pollutant and process and VMT.

– Adding combinations will increase run time.
– VMT results are selected here.  This will generate a warning.

You currently have no user input datasets.

Valid combination will not produce results if the fleet mix does not include these 
vehicles.  For example, electric cars are a valid combination, but no results will be 
reported if there are no electric cars in the fleet at the time and location you select.
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Setting up a Run Specification

You currently have no strategy inputs.
Name and create an output database.

– Do not name output the same as input databases.
– Use naming conventions:

Input – name_in
Output – name_out

Choose time/mass/distance units.
Choose output granularity.

Using consistent naming conventions will avoid confusion later.
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Output Emission Detail

This panel determines the granularity of the output.
By default, all results are aggregated by:

– Time
– Location
– Pollutant

Time and location can be further aggregated.
More detailed output can be obtained.
Source Classification Code (SCC) is a special case.
Do not select uncertainty until you understand it.
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This panel shows where you can describe your analysis.

A good description will help you keep track of your results.
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Choose Domain Scale of National.  Choose Calculation Type of Inventory.  (We will 
discuss Emission Rates later.)

This option allows you to access all of the default data stored in MOVES for the 
individual counties.
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Remember not to mess with the Time Aggregation Level until you understand what 
it does.
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I’ve picked two counties in Indiana, one with an I/M program and one without.
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The more fuel type / vehicle type combinations you choose, the longer the run will 
take.
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I chose all of the road types to make sure I get all of the activity.  Some activity 
occurs off of the highways (such as engine starts and some evaporative emissions) 
and will be omitted from the results unless the Off-Network road type is selected.
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I chose only pollutants from the Running Exhaust process.  Choosing more 
pollutants and processes will increase the time for the run.

This is where you can select output of the vehicle miles traveled (VMT).  This will 
cause a warning that you must set the units for distance on the General Output 
panel.
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You cannot select the units for distance unless you selected distance output on the 
Pollutants and Processes panel.
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I will not be getting output by model year or fuel type.  I have only chosen one 
emission process so selecting it will not differentiate any output, but by checking this 
box, the emission process field will be labeled (same for source use type). I will not 
be getting output by SCC.  These choices will not affect the time it takes to run the 
model, but can increase (or decrease) the size of the output table and the amount of 
time for post-aggregation.  You cannot disaggregate your output file once the run 
has been completed, so generally choose the most disaggregated scenario that you 
might ever need unless you are certain you do not need some detail.  Results can 
always be aggregated later (with some effort).

See what happens when you choose SCC, but change your selection back to what 
is shown above.
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Action: Execute

One last chance to make changes or otherwise stop the run.
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When running this screen will appear.

The time to completion estimates are very bad.  The execution progress bar is also 
not a good indicator as to how much time remains in the run.
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MOVES Worker

When you run MOVES, a worker will automatically be launched and generate this 
window.

This window will automatically close when the run is completed.
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MOVES Console Window

The MOVES console window shows you what MOVES is doing and will report 
problems.
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MOVES Shared Work Folder

The Shared Work folder is a subdirectory of the MOVES folder in the Program Files 
directory.  It shows you the ID of the Master and Worker and you can see the 
intermediate products (todo files, inprogress files and done files).

When a run is completed, the Worker ID file and all of the intermediate files will be 
gone.
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Run Completion

MOVES will generate this window to inform you that the run has completed.
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The Action menu has an option for MOVES Run Error Log that you can use to 
review any error or warning messages generated during your run.

You can also use this option to review error or warning messages generated during 
previous runs (by run ID) stored in the output database indicated in the loaded run 
specification.
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Error Log Window

This is what an Error Log Window looks like.  You can select the Run ID if more 
than one run is stored in the output database.
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This slide shows the 10 output tables created by MOVES in the indiana_mo
database using the MySQL Query Browser software.  The movesoutput table is 
shown. 
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MOVES Output

All results are stored in MySQL tables.
There are various options for viewing, exporting or 
processing the output.
We will discuss handling output next.
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Concepts: Aggregation

Aggregation of input:
– Reduces run time
– Changes the results.

Aggregation of output: 
– reduces the size of the output table.
– Permanently eliminates more detailed results. 

Don’t aggregate input until you understand it.
Generally: Perform any aggregation of output as a 
post-processing step.
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Aggregation

Input aggregation:
– Time Aggregation Level in the Time Spans panel.
– Region in the Geographic Bounds panel.
– These choices will affect your output aggregation options.

Output aggregation:
– Located in the Output Emissions Panel.
– By default, all output is already aggregated to time, location 

and pollutant.
– You must choose to get more detailed output by model year, 

fuel type, emission process, road type or vehicle class.
– You can also choose further aggregation of time and location.


